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GOLDWriter User's Guide

FPS GOLD's GOLDWriter  application allows you to create reports and gather data in an online, real-time
environment. It has been designed so you can quickly select fields, calculate additional work fields based on
user-defined selections, display complex totals and group calculations, and choose the application in which
you want to view the report.

This program facilitates system and user-defined calculations, sorting, subtotaling, exporting results, and up
to 4,000 bytes per row of information.

GOLDWriter is accessed in a Windows  environment. This environment provides a more user-friendly
graphical user interface (GUI) format. GOLDWriter has toolbars, menus, and keystrokes that help you
accomplish tasks quickly.

If you are unable to find the help you need from this user's guide, please call your FPS GOLD customer
service representative, and they'll be happy to help you.

You must have the current version of GOLDWriter. You can download the current version of GOLDWriter from
FPS GOLD's secure website, as explained in the steps below.

1. Access FPS GOLD's website at www.fps-gold.com. 

2. Log in with your user name, password, and institution number. 

3. Once in the secure area, click the Software Download link.

4. Scroll down to the GOLDWriter® link and click it.

5. Follow the steps that appear on your screen to download the latest version of GOLDWriter.

Note: You can identify what version of GOLDWriter you are currently using by selecting "About

GOLDWriter" from the Help menu. The About GOLDWriter dialog, as shown below, shows the version

number of GOLDWriter, copyright date, the machine, your institution set and number, and the numbers of

sessions in use.

http://www.fps-gold.com
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How to
Some of the most commonly asked questions about GOLDWriter  are answered in the following topics.

How do I...

Set up security for GOLDWriter?

Log On to GOLDWriter?

Open the Report Catalog, or refresh the current one?

Create a new report?

Open the Report Wizard to create a new report?

Copy an Existing Report?

Run Reports in the Afterhours?

View the Report Results?

Search for information in a report?

Example of how to calculate a work field column in Step 3 of the Report Wizard?

Example of how to calculate row selection logic in Step 4 of the Report Wizard?

Example of how to set up totals in Step 6 of the Report Wizard?

Change the report output folder?

Change the report setup folder?

Export the results of a report to another program?

Print from GOLDWriter?

Set up the printer before printing?

Save the current report?

Steps to change security code?
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Set up security for GOLDWriter
Before you can use GOLDWriter, security must be set up for each employee that will be using GOLDWriter.

NOTE

Someone in your institution (probably a supervisor or officer)
must have security to the Security > Setup screen in CIM
GOLD in order to set up preferences and options for
GOLDWriter.

To set up security:

1. Access the Security > Setup screen in CIM GOLD. 
2. Select the Employees radio button, and then select the employee name form the list view. For more

information about setting up security, see Setting Up Security in the CIM GOLD User's Guide on
DocsOnWeb.

3. Access the System tab.
4. Expand the FPS PC Applications node, and select either the Maintain or Inquire radio buttons next to

GOLDWriter Access, as shown below.
5. Click <Save Changes>.

Security > Setup Screen, System Tab in CIM GOLD

That employee now has access to GOLDWriter. They can log on to GOLDWriter as they do any FPS GOLD
application.

Your institution's security officer must give each employee access necessary for file maintenance or inquiry to
accomplish their tasks. File maintenance access allows employees to create, edit, and run reports in
GOLDWriter. Inquiry access allows employees to run reports, but they cannot create new reports or edit
existing reports.

https://secure.fps-https://secure.fps-gold.com/docsOnWeb/uguides/CIMGOLD/index.asp?settingupsecurity_cgug.asp
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Log on to GOLDWriter
You must have a security code and the proper security access if you want to open reports using GOLDWriter

. The Logon function enables you to log on to the host by typing in your user name and security code. 

GOLDWriter is a separate application from CIM GOLD; however, you can access and open GOLDWriter from
within CIM GOLD.

To log on to GOLDWriter from CIM GOLD:
1. From CIM GOLD, scroll to Other Applications in the left tree menu and expand the entry.
2. Click the GOLDWriter link. GOLDWriter launches with your logon credentials already entered.

Steps to log on to GOLDWriter stand alone
1. Click the GOLDWriter application logo on your desktop or from the Start menu. The Logon dialog box

will be displayed.
2. Enter your user name in the User Name field and your security code in the Security Code field.
3. Click <OK> or press <Enter>.

WARNING: If you enter an incorrect name or security code, the program will let you try again. After three
incorrect tries, the program will automatically close.

If you are not able to log on, check with your security manager to see if your security credentials have been
entered.

Change Security
Steps to change your security code
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1. On the Logon dialog, click the Change Security Code checkbox.
2. Type your user name in the User Name field and your current security code in the Security Code

field, then press <ENTER> or click <OK>. The Change Security Code dialog will appear.
3. Type a new security code in the New Security Code field, type it again in the Confirm New Code

field, then click <OK> or press <Enter>. Your security code has been changed.

Logon with Test Security
If your institution has a test file and you have access to log on with test security, you can select the Logon
With Test Security checkbox. Call your Customer Service representative if you have specific questions about
this.
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Menus and Icons
At the top of the GOLDWriter screen are menus and icons that quickly allow you to access various functions
within GOLDWriter. Each of these menus and functions are described in the Menus and Toolbar Icons
section.

See the following example of the menus and icons at the top of the GOLDWriter screen.
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Open the Report Catalog or Refresh the Current One
The Report Catalog displays all the reports that have been created on the host computer. It also displays all
the reports that have been created and saved on the current computer in use.

Each row contains identifying information about a single report. The Catalog is divided into columns that can
be dragged and dropped in any order. In addition, you can sort the Catalog list by any category by clicking on
the heading at the top of the column. All reports will sort in alphabetical or numerical order according to the
heading clicked on. 

To open the Report Catalog, click the  icon on the toolbar, or select "Refresh" from the Actions menu, or
press <F5>.

· To sort by any particular category, click on the heading at the top of that category.  All reports will sort
in alphabetical or numerical order according to the heading clicked on.

· To edit a report in the Report Wizard, highlight the report by clicking on it, and then select "Edit" from
the Actions menu or double-click on any report, or press <Ctrl> + E.

· To run a report, highlight the report by clicking on it, and then select "Run" from the Actions menu or
press <Ctrl> + R.

· To refresh the Report Catalog, click the  icon or press <F5>.

· To open the Report Catalog in a second window, select "New Window" from the Window menu.

The following is an example of the Report Catalog:

The icons in the Report Number column indicate whether the report is saved to the host ( ) or just saved to
your PC ( ). Saving a report just to your PC allows you to have a report that only you can run. This is
especially helpful when creating reports for employee accounts.

Note: FPS GOLD has already created many reports for you as examples for you to edit and use. They are
PC reports and are assigned numbers 1000 through 1036.
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Only reports saved to the host can run automatically in the afterhours.

You can run any reports listed on this screen, as described in the Actions Menu topic.

To create a new report to be displayed in the Report Catalog, see the Create a new report topic.
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Create a new report
There are four ways to create a new report:

1. Click the  icon on the toolbar to open the Report Wizard, which takes you step-by step to create a
report.

2. Select "New" from the Actions menu.

3. Select a report in the Report Catalog, and then copy and paste it as a new report into the catalog.

4. Press <Ctrl> + N

Whatever method you use, Step 1 of the Report Wizard is displayed.

FPS GOLD Reports

To help you get started with creating a report, FPS GOLD has set up some reports for you. These reports
are located in the PC section with the Category of "EXAMPLE." They are assigned report numbers 1000
through 1036. Examples included are for Loan, Deposit, and CIS reports. 

Double-click one of these report setups in the Catalog list, and the Report Wizard will start, where you can
make changes to these reports and save them with a new name.
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See also: 
Appendix A - Special Calculations
Appendix B - Special Loan Field Mnemonics
Appendix C - Report Examples
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The Report Wizard
The Report Wizard is used to create and edit GOLDWriter reports. Report Wizard automatically launches

when you want to create a new report or edit an old report; or you can click the  icon to start Report
Wizard. When Report Wizard opens, it takes you through a series of seven steps. The report number is
automatically assigned by the system, and is displayed in the Report Catalog. 

See the following steps for more information.

Note: FPS GOLD has already created many reports for you as examples for you to edit and use. They are
PC reports and are assigned numbers 1000 through 1036.

See also: 
Appendix A - Special Calculations
Appendix B - Special Loan Field Mnemonics
Appendix C - Report Examples
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The Report Wizard Step 1: Enter Basic Information

The first step of the Report Wizard is to enter basic information about the report. After clicking the Report
Wizard icon, the Report Wizard Step 1 screen is displayed, as shown below. 

The following steps explain how to complete Step 1 of the Report Wizard.

1. In the Title field, type whatever name you want to give the report.

The title appears on the Report Catalog and should be explanatory if other users will use the report.

2. In the Category field, type the category, or choose a previously entered category from the drop-down
list by clicking the down arrow.

The category is defined by your institution, and is used to group reports together by type of report, by
master file, by department, etc. You can type anything you want (including nothing at all) for a report
category. It also appears on the Report Catalog and can be very useful to your institution in separating
departmental reports.

3. Choose a Master Record from the drop-down list by clicking the down arrow.
After choosing a master record, new fields will appear just below the Master Record field. The fields
that appear will be different according to the master record you choose. 

The master record will also determine what other records can be used together on the report. The
master or main record will be the fields you will base your criteria and selection on. 

4. Enter the Account Number From and To information if you want to limit the extent of the report to a
specific range of account numbers. 

C Loan TIP: To place the branch portion of the account number into a separate column, use

LNOFFC then LNACT6. (This will place the 4-digit office in one column and the 6-digit
loan number in a separate column.) If you want to include the check digit, use
LNCKDG; this would place the check digit in a separate column. Example of a loan
number is 0014-512345-07.
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C TIP: If you want to run a report against a small number of accounts as a test run, you would only

need to enter a small range of account numbers in these fields. See View How Much a Report
Costs to Run for more information about setting up test runs.

5. To the right of the From and To fields is the Report Description field. Enter any notes you would like
to leave about the report (such as the purpose or when it should be processed) in this field. This
information will only show in the Report Wizard. 

6. If you would rather see mnemonics than field descriptions, check the Work with mnemonics rather
than field descriptions on all steps box. If you check this box, mnemonics will be used in all
subsequent steps of the Report Wizard. See the following example of mnemonics verses field
descriptions:

When you have finished entering your information, click <Next> at the bottom-right of the screen. Step 2 of
Report Wizard will appear.
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The Report Wizard Step 2: Select Fields

Step 2 of the Report Wizard allows you to select the records and fields you want to see when you run the
report. When a record or a field has a possibility of multiple occurrences, you can choose how many times a
record or a field will repeat in each report line. The following steps explain how to complete Report Wizard
Step 2, as shown below.

1. In the left pane, the master record you have chosen in Report Wizard Step 1 will appear, with a tree
structure of the other available records that can be combined below it. To see sub-records, click on the
<+> sign to the left of the main records. Right-click on any of the records to select the number of
occurrences of that record you would like to see in the report.

As you highlight any item in the tree structure, new database fields will appear in the center pane based
on the record selected. You need to proceed through all three steps in the left pane if you want to use
any fields in the Report Column Headings pane on the right.

2. To see a list of fields available for a record, click on the record. The center pane will fill with the fields
available from this record.

C TIP: Most fields within CIM GOLD are tied to a mnemonic. If you don't know a mnemonic for a field,

you can quickly find it by going to the CIM GOLD screen the field is on and use the <F1> field
help. The field name and mnemonic are displayed at the top of the field help. You can also set
your user preferences option to display the field mnemonic when you hover your cursor over a
field. This is set in Options > User Preferences, Enable Tool Tip Pop-up Help. See the
following example of the pop-up mnemonic next to a field:
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You can also search for the mnemonic in the CIM GOLD Master Help. To search for a
mnemonic, select "Master Help Search" from the Help menu, then click the Search tab, and
enter the mnemonic you want to search for in the provided field, as shown below. Click
<Display> to see a list of places in CIM GOLD where that mnemonic is referenced.

3. Place a check in the box to the left of each field name you want to appear on the report, or highlight it
and press the space bar. If you cannot find a field, use the Find field at the top of the center pane.
Enter any part of the field mnemonic or the description and the field will be highlighted. If it is the
desired field, press the spacebar and the field will be added. The field name will now appear in the
Report Column Headings box, with a colored square icon to the left of the field name. Number icons
are green, date icons are blue, and text icons are purple.

When you click on any column heading in the Report Column Headings box, the source record and
field will appear highlighted in the left and center panes.

When you are finished selecting all the fields you want to use on your report, click  <Next> in the
bottom-right corner of the screen. Step 3 of Report Wizard will appear.

Note: If you intend to use some fields in your calculations but do not want to see these fields displayed
on the report, they must still be selected in this step. What is shown on the report will be defined in a
later step in the Report Wizard.

See also: 
Appendix A - Special Calculations
Appendix B - Special Loan Field Mnemonics
Appendix C - Report Examples
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The Report Wizard Step 2A: Enter Sub-record Selection Logic

Step 2A of the Report Wizard allows you to enter logic specifying which sub-records will be used when the
report is run. This step is important for searching records that have multiple instances of the same record
(such as Reserve Disbursement records). 

For example, if you run a report on the Loan Master with the Reserve Disbursement as a sub-record, this step
allows you to select which Reserve Disbursements will be used. RDATYP = 10 would cause only fields from
Reserve Disbursements type 10 to be shown. All other Reserve Disbursement records would be skipped and
their fields not shown.

Logic can be entered for each sub-record type on the report. Syntax rules for entering logic are the same as
those for steps 3 and 4. If nothing is entered for a sub-record type, the report will use all sub-records of that
type.

See the following example of this screen:

1. In the left pane, select the record you want to add selection logic to.
2. In the middle pane, click the function you want to add and it will be displayed in the middle-bottom box.
3. Make any changes to the logic equation. You can add fields to the logic by clicking them in the right

pane, and they'll be added in the location of your cursor in the middle-bottom box.
4. Once everything is set up to your specifications, click <Next> to go to Report Wizard Step 3.

See also:
Definition of all Operators
Definition of all Functions
Appendix A - Special Calculations
Appendix B - Special Loan Field Mnemonics
Appendix C - Report Examples
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The Report Wizard Step 3: Create Work Field Columns

Step 3 of the Report Wizard allows you to create and edit additional work field or calculation columns on a
report. Twenty pre-defined functions are available to use in your calculations or work fields. There are also 21
operators to perform arithmetic and comparisons, and three choices of what type of data the result will be.
Work fields are needed when you want to use two or more mnemonics in creating a new calculation or when
you want to edit the results of a single mnemonic. Note: If you don't need special calculations on the report,
you can skip this step and proceed to the next step. (Click the <Next> button or <GoTo> button at the
bottom of the screen.)

See the following example of this screen:

The following steps explain how to complete Report Wizard Step 3.

1. To create a new column, click <New> in the bottom-middle pane.
An incomplete sentence will appear in the gray area below the functions. (See the following example.)

2. Complete the sentence by typing a name in the blank box, and then choosing a field type from the drop-
down list. The name you choose will be the column heading on the report and the name of your
calculated work field.

· The name must begin with a letter.
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· Spaces are allowed, but no punctuation is allowed.
· The name can be no longer than 20 characters.
· It cannot be the same name as one of the functions names (displayed in the Function column),

nor the same as one of the field names already displayed in the Report Column Headings pane.

Examples of valid field names could be My Calculation, Avg Weighted Rate, Days Negative, etc.

Examples of invalid field names might be P/I Payment (no special characters (such as /, -, +, etc.)
allowed), 1Field (must begin with a letter), ThisIsMyReallyLongField (longer than 20 characters), or Date
(same name as one of the functions).

3. Enter the equation, (that will be used to create a workfield), in the open space at the bottom of the
pane. You can create the equation using fields from the Report Column Headings box, the operator
buttons, and the functions listed in the Function box.

· To enter a field name, click on the field with the mouse. (You can also type the formula using the
keyboard.)

· To enter operators (e.g., =, +, -) click on the appropriate button. Also see the Definition of all
Operators section for definitions of all operators.

· To enter a function, double-click on the function name.
Most functions contain parameters enclosed within parentheses. These parameters should be
replaced with appropriate values or field names. The easiest way to do this is to double-click on the
parameter to be replaced, and then click on any field in the Report Column Headings box to
replace it. Functions without parameters must still be followed by parentheses. To see a definition
of all functions, see the Definition of all Functions section.

4. After the equation is complete, click <Finish>.

The newly created work field column will appear in the list of fields in the Report Column Headings
box. The new column will have a triangle icon  to its left, instead of a square , to show that it is a
work field column. This triangle will be colored to show what type of field is displayed. Number icons are
green, date icons are blue, and text icons are purple. Also see the Examples of How to Create a Work
Field Column section.

If you are viewing a report that has already been set up and want to see how a work field is calculated,
double-click the work field under the Report Column Headings, and the calculation will be displayed in the
box to the left, as shown below.

When you have created and edited the work field columns you want to see on your report, click <Next> in the
bottom right corner of the screen. Step 4 of Report Wizard will appear.
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See also: 
Appendix A - Special Calculations
Appendix B - Special Loan Field Mnemonics
Appendix C - Report Examples

Definition of all Operators

Steps 2A, 3, 4, and 6 of the Report Wizard offer several operators to be used in creating calculations. For
your convenience the complete definitions of all the available operators are listed below.

  (And)

The And operator has an expression to its left and to its right. It is a logical operator that resolves to
either 1 or 0 (true or false). For it to resolve to 1, both the left and the right expression must be true. For
example, if the following phrase is entered in the Step 4:Enter Row Selection Logic’s Select If: data
area

Current Balance > 0  &  Interest Rate = 0

only non-zero balance accounts that have a zero interest rate will be selected. If either the balance is
zero, or there is an interest rate, the account will not appear in the report.

  (Or)

The Or operator has an expression to its left and to its right. It is a logical operator that resolves to
either 1 or 0 (true or false). For it to resolve to 1, either the left or the right expression (or both) need to
be true. For example, if the following phrase is entered in the Step 4:Enter Row Selection Logic’s Select
If: data area

Current Balance > 0  |  Interest Rate = 0

any account that has a non-zero balance or has no interest rate will be selected. The only accounts
that would be skipped are zero balance accounts that have an interest rate.

  (Not)

The Not operator refers to the expression to its right. It changes a true expression to false and a false
expression to true. Because it may sometimes be confusing to read, it is often a good idea to include
the expression that is being changed in parentheses.  You can almost always use the other logical
functions in a different way to avoid using the Not operator. It is often difficult to understand because
most people tend to think positively. The easiest way to understand the Not operator is to understand
what it refers to and then do the opposite. For the following examples, assume the expression is being
used to select data.

! (Current Balance = 0)  
Would select all non-zero balance accounts.

! (Current Balance = 0 | Interest Rate = 0)
Would select all accounts with non-zero balances and rates.
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! (Acct Closed = YES)
Would select all open accounts

  (Equal to)

The Equal operator compares the expression to its left with the expression to its right. If they are
equivalent, it resolves to 1 (true). If not equal, it resolves to 0 (false). There are three different types of
fields: numeric, text, or date. You can only compare like types of fields together. Text fields are
compared alphabetically. For example, the expression Current Balance = 0 will be true if the account
balance is zero. The expression Product Code Descr = 'Super Checking' will be true if the account’s
product code description contains the text "Super Checking."

  (Not equal to)

The Not Equal To operator compares the expression to its left with the expression to its right and
returns 1 (true) if they are different, or 0 (false) if they are the same. See = above for more information
about comparisons.

Loan example: LNPBAL <> 5,000.00 would place loans with a principal balance not equal to 5,000.00
on the report.

  (Less than)

The Less Than operator compares the expression to its left with the expression to its right and returns
1 (true) if the left is less, or 0 (false) if the left is greater than or equal to the right. See = above for more
information about comparisons.

Loan example: LNPBAL < 10,000.00 would place accounts with a principal balance less than 10,000.00
on the report.

  (Greater than)

The Greater Than operator compares the expression to its left with the expression to its right and
returns 1 (true) if the left is greater than the right or 0 (false) if the left is less than or equal to the right.
See = above for more information about comparisons.

Loan example: LNPBAL > 10,000.00 would place accounts with a principal balance greater than
10,000.00 on the report.

  (Less than or Equal to)

The Less Than or Equal To operator compares the expression to its left with the expression to its right
and returns 1 (true) if the left is less than or equal to the right, or 0 (false) if the left is greater than the
right. See = above for more information about comparisons.
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Loan example: LNPBAL <= 5,000.00 would place accounts with a principal balance less than or equal
to 5,000.00 on the report.

  (Greater than or Equal to)

The Greater Than or Equal To operator compares the expression to its left with the expression to its
right and returns 1 (true) if the left is greater than or equal to the right, or 0 (false) if the left is less than
the right. See = above for more information about comparisons.

Loan example: LNPBAL >= 5,000.00 would place all accounts with a principal balance greater than or
equal to 5,000.00 on the report.

Certain fields ask a question such as the Account Closed field that can be answered yes or no. The
YES and NO operations are provided to help logical expressions be understood and used for these
fields. Note that these operations are not enclosed in quotation marks. Use these operations to select
for the question fields. For example, Club Account Feature = YES will select accounts that are club
accounts, and Account Closed = NO will select open accounts.

The Parentheses operations are used to create an expression of higher precedence than other
expressions. Expressions enclosed in parentheses are always done first. Parentheses can be
embedded within other parentheses. For example,

! ( (Club Acct Feature = YES  |  Acct Closed = NO) & (Current Balance <> 0))

the expressions in the inner parentheses are first evaluated, so the first expression is evaluated as true
if it is either a club account or an open account. The second expression is evaluated as true if the
current balance is not zero. Then those two expressions are evaluated as true only if each of the two
inner expressions are true. And finally, the whole result is made just the opposite. Therefore, this
complex expression will select those accounts that have a current balance of zero and that are neither
club accounts or open accounts. Or in other words, it will select all closed non-club accounts with a
non-zero balance. 

In the example, (Work1 + Work2) * Work3 the first two fields will be added before multiplying by the
third field. Since multiplication is done before addition, if there were no parantheses, Work2 would be
multiplied by Work3 before adding Work1.

  (Comma)

This operator allows you to separate values used in a value list. 

Loan example: Collateral code = 17, 20, 25, 40 would place all loans with a collateral code equal to 17,
20, 25, or 40 on the report.
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  (Tilde)

This operator allows you to designate a range of values in a value list. Enter the start value, then a ~
symbol, then the ending value.

Loan example: LNTYPE = 5 ~ 20 would place accounts with a loan type equal to 5 through 20 on the
report.

      

The IF, THEN, ELSE operation allows you to make logical decisions in selecting what data you want to
use. They are only available in Report Wizard Step 3: Create Work Field Columns and Report Wizard
Step 6: Setup Totals. The IF statement is followed by a logical expression. If its result is true, the
expression following the THEN statement is used to fill in the work field or the total field. If it is false, the
expression following the ELSE statement is used to fill in the work field or total field. The ELSE is
optional and does not have to be there. If there is no ELSE, then the field will get its default value - blank
for text, 0 for numbers, and undefined  (zero) for dates.

It is legal to use IF statements within the THEN or ELSE statements as long as they eventually resolve
to a value of the type designated for the work field or the total field. You must use parentheses to avoid
ambiguity when you do this. Examples:

IF Work1 > Work2 THEN ‘OK’ ELSE ‘BAD’ 
This expression will place OK in a text work field if Work1 is greater than Work2. If it’s not, then
the text field will get BAD.

IF Account Closed = YES THEN
   (IF Current Balance <> 0 THEN 1 ELSE 2)  ELSE 3 

This expression will place a 1 in a numeric field for a closed account with a non-zero balance, a
2 in the field for closed accounts with zero balances, and a 3 in the field for open accounts.

IF Work1 = Work2 THEN ‘SAME’
This expression will put the word SAME into a text field if Work1 and Work2 are equal.
Otherwise, it will leave it blank.

Adds the value on the right side of the + to the value on the left side 

Subtracts the value on the right side of the - from the value on the left side

Multiplies the value on the left side by the value on the right side

Divides the value on the left side by the value on the right side

Modulus - divides the value on the left side by the value on the right side and returns the remainder. For
example 12 % 7 returns 5 because 7 goes into 12 once with a remainder of 5.
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Exponent - raises the value on the left side to the power of the value on the right side. The right side
value must be a positive integer. For example, 4  ̂3 will give 64 because 4 cubed is 64.

Value List

A value list is a list of values that can be used on the right side of = or <> operators. When you use a value
list, if the expression on the left side of the = is equal to any of the values in the list, the expression is true.
If the expression on the left side of the <> operator is not equal to any of the values in the value list then the
expression is true. The list may include single values or value ranges separated by commas. A value range
is a start value, then a ~, then the end value. 

The following are some examples of expressions using value lists and their results. For these examples,
assume that the field MyCode contains the number 4, and that the field OtherCode contains the number 10. 

MyCode = 1, 2, 3, 10, 12         Result: false - 4 is not in the list
OtherCode = 1, 2, 3, 10, 12  Result: true - 10 is in the list
MyCode <> 1, 2, 3, 10, 12  Result: true - 4 is not equal to any list value
OtherCode <> 1, 2, 3, 10, 12  Result: false - 10 is equal to one of the list values
MyCode = 1, 3~7, 11  Result: true - 4 is in the range of 3 through 7.
MyCode <> 1, 3~7, 11  Result: false - 4 is in the range of 3 through 7.

Definition of all Functions

Steps 3 and 4 of the Report Wizard offer several functions to be used in creating calculations. For your
convenience the complete definitions of all the available functions are listed below.

ADDDAYS( aDate, aNumber)    
Adds the number of days specified by aNumber to the date specified by aDate to give a new date. For
example, to calculate the date 10 days past the loan due date you would type ADDDAYS( LNDUDT, 10). To
calculate the date 10 days before the due date you would type ADDDAYS( LNDUDT, -10).

ADDMONTHS( aDate, aNumber)    
Adds the number of months specified by aNumber to the date specified by aDate to give a new date. For
example, to calculate the date 3 months past the loan due date you would type ADDMONTHS( LNDUDT, 3).
To calculate the date 3 months before the due date you would type ADDMONTHS( LNDUDT, -3).

ADDYEARS( aDate, aNumber)    
Adds the number of years specified by aNumber to the date specified by aDate to give a new date. For
example, to calculate the date 7 years past the loan due date you would type ADDYEARS( LNDUDT, 7). To
calculate the date 7 years before the due date, you would type ADDYEARS( LNDUDT, -7).

ALL (RepeatingField =<><=>= value)
This function is an advanced function that allows you to test all values of a repetitive field for certain
conditions. For example, there are 12 Deposit Master hold and action code fields that all have the same
mnemonic (DMHACC). This function can test all 12 of these fields using this function. To use this function,
replace "aRepeatingField" with the name of the field to be tested. Replace "aLogicalOperator" with one of the
following operators: = (is equal to), <> (is not equal to), > (is greater than), >= (is greater than or equal to), <
(is less than), or <= (is less than or equal to). Replace "aValueList" with either a single value or a list of values
separated by commas. If this expression is true, its value becomes 1. If it is false, its value is 0. This can be
used in conjunction with the IF, THEN, and ELSE operators to make quick decisions.
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Note: A list of values can only be tested using equal (=) or not equal (<>).

For example, if you wanted to select all accounts that have no hold codes, you could type ALL( Hold Action
Code = 0). Only accounts that have all hold codes equal to 0 would be selected.

When using the ALL function, the statement must be true for each of the repeated fields or else it will be
false. If we used ALL( Hold Action Code <> 0) in the example above, then only accounts that have a non-zero
value in each of the 12 hold code fields would be selected. Refer to the "ANY" function for selecting if any of
the items are true.   

Note: The "ANY" and the "ALL" functions are used to test repeated fields within a given record. The
"FORANY" and the "FORALL" functions described below are used to test fields that occur in multiple records
linked to a master record. Except for this difference, these functions are very similar.

ANY (RepeatingField =<><=>= value)
This function is an advanced function that allows you to test for any repetitive field for certain conditions. For
example, there are 12 Deposit Master hold and action code fields that all have the same mnemonic
(DMHACC). This function can test all 12 of these fields to see if any of them have the desired values using this
function. To use this function, replace the parameter, aRepeatingField, with the name of the field to be tested.
Replace aLogicalOperator with one of the following operators: = (is equal to), <> (is not equal to), > (is greater
than), >= (is greater than or equal to), < (is less than), or <= (is less than or equal to). Replace the parameter,
aValueList, with either a single value or a list of values separated by commas. If this expression is true, its
value becomes 1. If it is false, its value is 0. This can be used in conjuction with the IF, THEN, and ELSE
operations to make quick decisions.

Note: A list of values can only be tested using equal (=) or not equal (<>).

For example, IF ANY( Hold Action Code = 6, 7, 11) THEN ‘LEGAL’ ELSE ‘ ‘ used in a work field will place the
word LEGAL into the field if any one of the 12 hold codes on the account contain any of the values 6, 7, or 11.
If none of 12 contain 6, 7, or 11 then it places a blank into the work field.

If in this same report we included the selection ANY( Hold Action Code <> 0) we would get a report that shows
all accounts that have any holds at all containing a column with the word LEGAL for accounts with a hold code
of 6, 7, or 11. 

When using the ANY function, if the statement is true for any of the repeated fields the statement is true. If we
used !(ANY( Hold Action Code = 0)) in the example above, then only accounts that have a non-zero value in
each of the 12 hold code fields would be selected. Refer to the ALL function for selecting if all of the items are
true.

Note: The ANY and the ALL functions are used to test repeated fields within a given record. The FORANY and
the FORALL functions described below are used to test fields that occur in multiple records linked to a master
record.

DATE( aMonth, aDay, aYear)
Creates a date field from numeric fields. The valid values for aMonth are 1 - 12 (January - December). The valid
values for aDay are 1 - 31 (depending on the month and the year). The field, "aYear," includes the century. For
example, August 27, 2010, would be entered as DATE( 8, 27, 2010)

DAY( aDate)
Returns the day of the date given in aDate. For example, the day of August 27, 2010 is 27.

DIFFDAYS( StartDate, EndDate)



How to28

© 2024 FPS GOLD. All rights reserved.Last updated: 10/3/2024

Returns the number of days from the start date to the end date. If the end date is prior to the start date, the
value returned is negative.

DIFFMONTHS( StartDate, EndDate)
Returns the number of full months from the start date to the end date. If the end date is prior to the start date,
the value returned is negative.

DIFFYEARS( StartDate, EndDate)
Returns the number of full years from the start date to the end date. If the end date is prior to the start date,
the value returned is negative.

FIND( ‘Value’, Field)
Searches a text field (Field) for a given substring (Value). If the substring is found, the position of the first
location of the substring is returned. If it is not found 0 is returned. This can be used for searching for certain
values in text fields and determining if they exist or not. For example:
 

IF FIND( ‘AUTO’, Collateral Description) THEN ‘Car Loan’

If the collateral description contains the word AUTO anywhere within it then the text Car Loan is placed into
the text work field for which this is defined.

FORALL record( aLogicalExpression)

FORANY record( aLogicalExpression)
FORALL tests the aLogicalExpression for each of the records specified by record and returns 1 (true) if all of
them are true, otherwise it returns 0 (false).

FORANY tests the aLogicalExpression for each of the records specified by record and returns the count of
items that are true. If none are true, it returns 0. For this function 0 is false, and non-zero is true.

These advanced functions are used when multiple sub-records are linked to a master record to apply the
logical expression to all of the sub-records. Examples of situations where records may be linked in this
manner include multiple history records linked to a master record or multiple reserve disbursement records
linked to a loan master record. The multiple records are linked to the master record in Report Wizard Step 2:
Select Fields. It is possible to link records to records for several levels. For example, you may want to link
the Reserve Disbursement record to the Loan Master record for a report. You may then want to link several
Company Agents to the Reserve Disbursement record. When multiple records are linked in this manner, the
complete field name includes the path through all the linked records to get to the field. The root record (which
is the main record that you first selected for the report) is not included in the path name. One of the fields in
the Company Agent record is the Payee Number. The path of the 1st occurrence of this field in the report is:

ReserveDisbursement1.CompanyAgent1.PayeeNumber 

Notice that the records in a path name are separated by periods and that the count of a record is appended
to the record name. In the example above the third Reserve Disbursement record would be
ReserveDisbursement3.

In the FORALL and the FORANY functions, you replace the record parameter with the complete path name
less the record count for the record you desire to work with. For example, if you want to test all the Payee
Numbers tied to the loan master to see if they are zero you would type the following:

FORALL ReserveDisbursement.CompanyAgent( PayeeNumber = 0)
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This would apply the logical expression within the parentheses to each of the Company Agent records within
the Reserve Disbursement records.

How would you code FORALL or FORANY for a path that contains multiple links of multiple records? Let’s
consider that the ABC record is a record linked to a master record. It has 5 multiple linked XYZ records tied
to it. For each of these 5 we have linked 2 QRS records. In the QRS record, there is a field called MyField
that we want to reference. This means that for each ABC record we read, there are 10 MyFields that we want
to access. The paths to these fields are:

ABC1.XYZ1.QRS1.MyField
ABC1.XYZ1.QRS2.MyField
ABC1.XYZ2.QRS1.MyField
ABC1.XYZ2.QRS2.MyField
ABC1.XYZ3.QRS1.MyField
ABC1.XYZ3.QRS2.MyField
ABC1.XYZ4.QRS1.MyField
ABC1.XYZ4.QRS2.MyField
ABC1.XYZ5.QRS1.MyField
ABC1.XYZ5.QRS2.MyField

If we wanted to test to see if any of these fields contained the value 12 we could type 10 IF statements and
fill out the complete path name to each field. That would become very difficult if there were dozens of
MyFields instead of just 10. Or we can use a FORANY statement to test them in a single IF statement. For
example consider the following:

IF FORANY ABC.XYZ.QRS( MyField = 12) THEN ‘GOTIT’

If any of the 10 fields contain the number 12, this statement will place the text GOTIT into the text field for
which this is the definition.

Now let’s suppose that we only want to test MyField if the field XYZcode in the XYZ record is 'Y.' We want to
ignore any records for which the XYZcode is not 'Y.'  A statement to perform this function looks like this:

IF FORANY ABC.XYZ( XYZcode = ‘Y’ & FORANY QRS( MyField = 12)) THEN ‘GOTIT’

Notice that the inner FORANY statement does not have the ABC.XYZ portion of the path name. That is
because it is supplied by the outer FORANY statement. The outer statement will process ABC.XYZ records
1 through 5. The inner statement will process the QRS 1 and 2 records for each of the outer ABC.XYZ
statements. In this example, the MyField will be tested to see if it is equal to 12 only if the XYZcode field of
the XYZ record contains ‘Y’.

It is legal to mix the nesting of FORALL and FORANY functions. In the example above if the inner function is
FORALL instead of FORANY the outer FORANY function will return true only if at least one ABC.XYZ
records has the XYZcode field equal to ‘Y’ and both QRS1.MyField and QRS2.MyField are equal to 12.

What is a valid aLogicalExpression? A logical expression is something that compares one thing to another
and returns true. You can use a value list in these expressions just as you can in the ANY and ALL
functions described above. Continuing to use the example of MyField above, the following are some
examples of valid logical functions.

1. MyField < 30
2. MyField = 6, 7, 21
3. MyField > 20 & MyField < 35
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4. MyField = AnotherField | MyField = 0
5. (MyField + AnotherField) > 100

The first is true if MyField is less than 30. The second is true if MyField is equal to 6, equal to 7, or equal to
12. The third is true if MyField is equal to 21 through 34. The fourth is true if the value in MyField is the same
as the value in AnotherField or if MyField is zero. The fifth is true if the sum of MyField and AnotherField is
greater than 100.

Note: The ANY and the ALL functions described above are used to test repeated fields within a given record.
The FORANY and the FORALL functions are used to test fields that occur in multiple records linked to a
master record. Except for this difference, these functions are very similar.

MONTH( aDate)
Returns the month of the date given in aDate. For example, the month of August 27, 2010 is 8.

ROUND( aNumericalFieldOrExpression, aNumberOfDecimalPlaces)
Rounds the aNumericalFieldOrExpression to the number of decimal places specified by
aNumberOfDecimalPlaces. If the digit following the desired decimal place is 0-4 the number is rounded
down. If it is 5-9, the number is rounded up. If the round function is used to create a number that has more
decimal places than it currently has, no rounding takes place. The resulting number will have the number of
decimal places specified by aNumberOfDecimalPlaces. The following examples show how the round function
works.

ROUND( 123.456, 1)         Result: 123.4
ROUND( 123.456, 2)         Result: 123.46
ROUND( 123.456, 3)         Result: 123.456
ROUND( 123.456, 4)         Result: 123.4560
ROUND( 123.456, 5)         Result: 123.45600

RUNDATE()
Returns today’s date (the date that the report runs).

TRUNCATE( aNumericalFieldOrExpression, aNumberOfDecimalPlaces)
Truncates the aNumericalFieldOrExpression to the number of decimal places specified by
aNumberOfDecimalPlaces. No rounding is performed. If the truncate function is used to create a number that
has more decimal places than it currently has, zeros are added to the end. The result number will have the
number of decimal places specified by aNumberOfDecimalPlaces. The following examples show how the
truncate function works.

TRUNCATE( 123.456, 1)         Result: 123.4
TRUNCATE( 123.456, 2)         Result: 123.45
TRUNCATE( 123.456, 3)         Result: 123.456
TRUNCATE( 123.456, 4)         Result: 123.4560
TRUNCATE( 123.456, 5)         Result: 123.45600

YEAR (aDate)
Returns the year of the date given in aDate. For example, the year of August 27, 2010 is 2010.

Examples of How to Create a Work Field Column

The following example creates a work field called "Warning." Warning will contain the word "Legal" if any of
the hold codes is a legal hold code, as specified by the hold code number.
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Steps
1. From Report Wizard Step 3, click <New>.

An incomplete sentence will appear in the bottom of the screen, like the one outlined below.

2. In the empty box on the left, enter a title.
For this example, the title will be "Warning."

3. In the drop-down list to the right of the title, select what type of field you are creating.
For this example, the type will be "TEXT."

4. In the white space below the sentence, create the calculations for your new column. (See steps 5-15
for instructions on how to create calculations.)

5. Click .
IF now appears in the white box below the sentence.

6. Select "ANY(RepeatingField =<><=>= value)" from the Function list.
The following expression will appear after the word IF:

ANY(RepeatingField =<><=>= value)

7. Double-click on the words "RepeatingField" in the new formula.
RepeatingField is now highlighted.

8. Click on "Hold Action Code" in the Report Column Heading list.
"RepeatingField" will be replaced by "Hold Action Code." 

9. Click and drag the mouse across <><=> in the formula. 

10. Press <Delete> on the keyboard.



How to32

© 2024 FPS GOLD. All rights reserved.Last updated: 10/3/2024

11. Double-click on the word "value," and type "6,7,13."

12. Click outside the parenthesis after "6,7,13," and click .
The word THEN now appears.

13. After the word THEN, type a space and the word "'legal'."

14. Click .
The word ELSE now appears after "'legal'."

15. After ELSE, type two single quotation marks separated by a space like this: ' '.

The calculation is now complete and looks like the following: 

The completed equation says, "If any hold action code equals 6, 7, or 13, then the word legal will
appear on the report, otherwise the space on the report will be blank."

16. Click  and the work area will close.
The Warning workfield will appear in the Report Column Headings list.

Additonal example of how to create a work field column

For your understanding, the following is an example of how to create a work field.

Steps

1. From Report Wizard Step 3, click <New>.
An incomplete sentence will appear in the bottom of the screen, like the one outlined below.

2. In the empty box on the left, enter a title.
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For this example, the title will be "Funny."

3. In the drop-down list to the right of the title, select what type of field you are creating.
For this example, the type will be "TEXT."

4. In the white space below the sentence, create the calculations for your new column. (See steps 5-15 for
instructions on how to create calculations.)

5. Click .
IF now appears in the white box below the sentence.

6. Click "Hold Action Code" in the Report Column Headings list.
"Hold Action Code" will appear after the word IF.

7. Click the "+" symbol.
The "+" symbol will appear after "Hold Action Code."

8. Click "Hold Action Code2" in the Report Column Headings list.
"Hold Action Code2" will appear after the "+" symbol.

9. Click the ">" symbol.
The ">" symbol will appear after "Hold Action Code2."

10. Type "10" after "Hold Action Code2."

11. Click .
The word THEN appears after "10."

12. Type "'FUNNY'" after the word "THEN.".

13. Click .
The word ELSE now appears after "'FUNNY'."

14. After ELSE, type word "'BORING'."

The calculation is now complete and looks like the following: 
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The completed equation says, "If Hold Action Code 1 added to Hold Action Code 2 is greater than 10,
then the word FUNNY will appear on the report; otherwise, the word BORING will appear."

15. Click  and the work area will close.
The Funny workfield will appear in the Report Column Headings list.
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The Report Wizard Step 4: Enter Row Selection Logic

Step 4 of the Report Wizard allows you to enter row selection logic to determine which rows you would like to
see when the report is run. For example, you may not want accounts with a zero balance to appear on the
report when it is run. If nothing is entered in this setup, all rows are downloaded to the PC. You could also
export the file to another application such as Excel, and make your selection criteria in Excel.

1. Using fields from the Report Column Headings, the operator buttons, and the functions in the top left
pane, enter a logical statement that can be determined to be true or false.

For example, a selection logic statement, Location1.Requires Flood Insur = Yes, would only select
loans that required flood insurance based on the location of the property.

See the examples in Appendix A of some real report setups.

When you have entered the row selection logic to determine which rows you would like to see on your report,
click <Next> in the bottom-right corner of the screen. Step 5 of Report Wizard will appear.

See also:
Example of How to Create Row Selection Logic
Definitions of all Operators
Definition of all Functions
Appendix A - Special Calculations
Appendix B - Special Loan Field Mnemonics
Appendix C - Report Examples

Example of How to Create Row Selection Logic

For your understanding, the following is an example of how to create row selection logic in Step 4 of the
Report Wizard.
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Steps

1. In Report Wizard Step 4, click in the large white box at the bottom of the screen.

2. Type "!" then a space, then a "(" symbol.
"! (" now appears in the white box.

3. Select "ALL(RepeatingField =<><=>= value)" from the Function list.
The following expression will appear after "! (":

ALL(RepeatingField =<><=>= value)

4. Double-click on the words "RepeatingField" in the new formula.
RepeatingField is now highlighted.

5. Click on "Hold Action Code" in the Report Column Heading list.
"RepeatingField" will be replaced by "Hold Action Code." 

6. Click and drag the mouse across <><=>= in the formula. 

7. Press <Delete> on the keyboard.

8. Double-click on the word "value," and type "0."

9. Click outside the parenthesis after "0," and click  .

The calculation is now complete and looks like the following: 

The completed equation says, "Select this field if not all Hold Action Code information equals 0."
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The Report Wizard Step 5: Setup Sorting and Breaks

Step 5 of the Report Wizard allows you to select sorting and subtotal breaks you would like to see when you
open a report. Note: If you do not want to sort or have breaks in the report, you can skip this step and
proceed to the next step. Click the <Next> or <Goto> button. If after running the report you decide you want it
sorted or breaks included, just return to this step and make the changes.

The following steps explain how to complete Report Wizard Step 5.

1. Drag and drop the columns you want to be sorted from the left window into the right window.
2. Enter a check by a column to see a subtotal break in the report each time the data in that column

changes.
3. Right-click on any column in the right window to choose between ascending or descending order

(indicated by the green arrow to the left of the column title).
4. Select where the report will be displayed in the View results with box.

· To see the data displayed in GOLDWriter, click the GOLDWriter radio button.

· To see the report results in another application, such as Microsoft® Excel, click the second radio

button, and then click the browse icon  to the right of the field below GOLDWriter. The Open
dialog will appear. Browse to the application you want to see the report results in and double-click
on the executable file. If you want to go directly to another application, without displaying the report
in GOLDWriter first, select the second radio button below the GOLDWriter field.

C TIP: If you would like to preview a report in GOLDWriter before exporting it to another application,

click the GOLDWriter radio button, but enter the application name in the box beside the
second radio button. When you run this report, it will display in GOLDWriter. Then clicking

the export icon  on the toolbar will send the report to the entered application.

5. For a report on which you do not want to see detailed information, check the Totals Only box.
6. To see corresponding mnemonics displayed in the column headings, check the Show Mnemonics

box. 
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7. To turn off descriptions in report column headings so the user will see just the mnemonics or nothing at
all, check the Show Descriptions box.

8. To strips commas from numeric fields for external program export, check the Strip Commas box.

When you have set up the sorting and subtotal breaks you want to see on your report, click <Next> in the
bottom-right corner of the screen. Step 6 of Report Wizard will appear.
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The Report Wizard Step 6: Setup Totals

Step 6 of the Report Wizard allows you to set up totals you would like to see when you run a report.

If you right-click on a report column heading in the Report Column Headings box, a pop-up menu appears
where you can define a total, average, minimum, maximum, weighted rate, Weighted Average Remaining
Maturity (W.A.R.M.), or Percent of Total for the column, if this type of calculation is possible. It is okay to
select more than one type of total for a column. Once you select a total from the pop-up menu, that total will
be displayed in the Report Totals window in the bottom-right of the screen, as shown in the following
example.

Weighted rate and W.A.R.M. totals require multiple steps. The following directions explain how to set up
weighted rate and W.A.R.M. totals.

Steps to Create a Weighted Rate Total

1. Right-click on a rate in the Report Column Headings box, and select "Wtd. Rt." from the pop-up
menu. A message will appear asking you to choose a balance.

2. Click on a balance in the Report Column Headings box, and the new report total will appear in the
Report Totals box on the bottom-right corner.

Steps to Create a W.A.R.M. Total

1. Right-click on a date in the Report Column Headings box, and select "W.A.R.M" from the pop-up
menu. A message will appear asking you to choose a balance.

2. Click on a balance in the Report Column Headings box, and the new report total will appear in the
Report Totals box on the bottom-right corner.

After creating a total, you can right-click on the total in the Report Totals box to delete, edit, or create a new
total. Totals can use data from multiple columns. You may, for example, divide the total of one column by the
average of another column.
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When you have set up totals you want to show up on your report, click <Next> in the bottom-right corner of
the screen. Step 7 of Report Wizard will appear.

See also:
Example of How to Create Totals
Definitions of all Operators
Definitions of all Functions in Step 6

Example of How to Create Totals

For your understanding, the following is an example of how to create totals.

Steps

1. In Step 6 of the Report Wizard, right-click on any field in the Report Column Headings box.

2. Select the type of total you want from the menu that appears.
The newly created total will appear in the Report Totals box.
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3. To edit a total field in the Report Totals box, double-click on it.
The total calculation will appear in the large white box on the left.

4. Insert any new functions or operators, then click .

See also:
Definitions of all Operators
Definitions of all Functions in Step 6

Definitions of all Functions in Report Wizard Step 6

Step 6 of the Report Wizard offers several functions to be used in creating calculations. For your
convenience, the complete definitions of all the available functions are listed below.

AVERAGE( Column)
Gives the average of the values in the given column. The average is calculated by dividing the sum of all
items in the column by the number of items in the column.
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For a subtotal segment, it gives the average of the items in the segment. For final report totals, it gives the
average for all items in the column.

COUNT()
Returns the number of detail rows in a subtotal segment for subtotals and the number of all detail rows for
the report final totals.

GROUPPERCENT( Column )
Gives the group percentage of the grand total for the given column.

MAXIMUM( Column)
Gives the maximum value of the values in the given column. For a subtotal segment, it gives the maximum
of the items in the segment. For final totals, it gives the maximum of all items in the column.

MINIMUM( Column)
Gives the minimum value of the values in the given column. For a subtotal segment, it gives the minimum of
the items in the segment. For final totals, it gives the minimum of all items in the column.

TOTAL( Column)
Gives the total of the values in the given column. For a subtotal segment, it gives the total of the items in the
segment. For final totals, it gives the total of all items in the column.

WARM( MaturityDateColumn, BalanceColumn)
Gives the weighted average number of remaining months to maturity weighted by the balance of the
account. For subtotals, it returns the value for those rows in the subtotal group. For final totals, it returns the
value for all rows.

To calculate the WARM, the function calculates the number of months from the report run date to the
maturity date. It then multiplies this number of months by the balance to create a factor. The sum of all the
factors divided by the sum of all the account balances gives the WARM value. Mathematically, the formula
looks like

( Remaining Months * Balance)
------------------------------------------------------

( Balance)

WTDRT( RateColumn, BalanceColumn)
Gives the weighted average rate weighted by the balance of the account. For subtotals, it returns the value
for those rows in the subtotal group. For final totals, it returns the value for all rows.

To calculate the WTDRT, the function multiplies the rate by the balance to create a factor. The sum of all
the factors divided by the sum of all the account balances gives the WTDRT value. Mathematically, the
formula looks like

( Rate * Balance)
---------------------------------

( Balance)
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The Report Wizard Step 7: Set Column Order

Step 7 of the Report Wizard allows you to reorganize the report columns and select which columns should
appear on the report.

The selected fields and work fields you selected in the previous Report Wizard steps are displayed here. The
order the fields appear here will be the same order as how they appear on the report. For example, the first
checkmarked field will be the first column on the report.

To move a field, simply click and drag the field to the desired position.

If you want the field to appear on the report, check the box in front of the field. If you do not want the field on
your report, leave the checkbox blank, and the field will be hidden. This is especially useful when using fields
to build work fields and logic, but they are not necessary on a stand-alone basis.

See the example below:

Note: After a report has been run and displayed, columns can be temporarily moved where you need them.
When the report is run later, the columns will appear in the order defined in Step 7. Also, when a report is
exported to another application such as Excel, the columns will automatically appear in the order defined in
Step 7.

When you have reorganized the report columns, click <Save> in the bottom-right corner of the screen. The
following dialog will appear:
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· Click <Continue without running the report> and the report will be saved to the Report Catalog,
where you can run it at a later time or schedule it to run in the afterhours.

· Click <Run the report> to run the report immediately. The results of the report will be displayed on
the screen, and you can print, save, or export the report to another program (such as Excel).

· Click <Run the report in batch mode> to run the report in batch mode. This means that
GOLDWriter requests a lower priority from the host to run the report. The biggest difference when
running the report in batch mode is that the cost of the report will be about 1/3 less, and the
report may take a little bit longer to run. However, in most cases the run time is about the same. 

· The <Install as host selection setup for CIM> is a special function that saves only the selection
parameters of the report into a format on the host computer that is used in Contact Queue
processing. It requires that a Contact Queue with the same name as the GOLDWriter report has
already been set up in CIM GOLD. Clicking this button assigns the logic of the report to the
Contact Queue so that the Contact Queue will pull the same accounts as the GOLDWriter report.
If that Contact Queue is not set up before you click this button, you will receive an error message.
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Open the Report Wizard to create a new report
If you want to create a new report, or edit an old one, the Report Wizard will allow you to do this.

Steps for creating a new report
1. Select "New" from the Actions menu.
2. The Report Wizard will appear.

Use the seven steps of the Report Wizard to create a report. 
3. When you have completed the Report Wizard, the following message will appear: "Report setup has

been saved. Would you like to run this report now?"
4. If you want to run the new report, click <Yes>. If you do not want to run the report, click <No>.

The report will automatically be saved.

Steps for editing an old report
1. Highlight the report by single-clicking on it in the Report Catalog, then select "Edit" from the Actions

menu.

 " Remember: FPS GOLD has already created many report examples for you to copy, edit, and use.

The Report Wizard will appear.

2. Make any changes you need throughout the seven steps of the Report Wizard. 
3. When you have completed the Report Wizard, the following message will appear: "Report setup has

been saved. Would you like to run this report now?"
4. If you want to run the new report, click <Yes>. If you do not want to run the report, click <No>.

The report will automatically be saved.

WARNING: When scheduling a GOLDWriter report to run in the afterhours, the final step is to refresh the
catalog so that the schedule can be written to the host computer.
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View the Report Results
The report results are displayed after a report is run. You can view the results from the run in the following
ways:

· After successfully completing Step 7 of the Report Wizard, a dialog box is displayed where you can
choose to run the report.

· Select a report you want to view on the Report Catalog screen, and then select "Run," "Run & Print,"
"Run Batch Mode," "Run on PC Database," or "Schedule for Afterhours" from the Actions menu.

· Right-click a report you want to view on the Report Catalog screen. The following pop-up menu appears:

Select one of the run options: Run, Run&Print, Run Batch Mode, Run on PC Database, Schedule for
Afterhours. 

The report is divided into columns that can be dragged and dropped in any order. Clicking on any column
heading will display the report in the order used for that column. See the following example of a report that
was generated by GOLDWriter called "Loans with Late Fees."
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If subtotals were selected in Step 5 of the Report Wizard, they will be displayed on the report. The subtotals
disappear whenever a column order change would make the subtotals incorrect. 

The following functions can be performed when a report has been run.

Charge amount

Export results 

Print

Save report
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Charge Amount

The Charge Amount  icon can only be used after a report has been run. This icon does not work on old
reports that have been run and saved on your computer.

Clicking the  icon will open a screen detailing how much was billed for the last report run.

See View How Much a Report Costs to Run for more information.
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Export a report to another program

It is possible to export a report to another spreadsheet or database program. This must be set up just once in

Step 5 of the Report Wizard. If, when a report is displayed, the arrow on the toolbar is yellow , click it to

export the report to a designated spreadsheet or database program. If the arrow on the toolbar is gray ,
complete the following steps.

Steps 

1. Open the Report Catalog by clicking the  icon on the toolbar.

2. Right-click on any report.

3. Select "Edit" from the pop-up menu, and Step 1 of the Report Wizard will appear.

4. Click <GoTo>, and select "5 Sorting & Breaks" from the pop-up menu.

5. Step 5 of the Report Wizard will appear.

6. In the View results with box, select the GOLDWriter radio button, then click the browse button, .
The Open dialog will appear.

7. Browse to the folder that contains the application you want to view the report in, and double-click on it. 
For example, if you wanted to view the report in Excel, you would find the folder that contains the Excel
application and double-click on the Excel executable file.

CTIP: If you want to open the report directly from Step 5 of Report Wizard, without displaying the

report in GOLDWriter first, select the second radio button.

8. Click <GoTo>, and select "Save & Run" from the pop-up menu that appears.

9. If you selected the second radio button (see TIP above), the report results will automatically appear in
the new program you selected in Step 7. If you selected GOLDWriter, the report results will appear in
GOLDWriter report results.

10. To see the currently displayed results in the new application, click the  button on the toolbar.
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Print from GOLDWriter

To print a report from GOLDWriter, you must first create and run the report. For more information on how to
create and run a report, see the Report Wizard section. Once the report has been run, you can print the
report to either of two destinations: a Windows printer or a PC file. If it is sent to a PC file, you can retrieve the
data at any time. 

Steps to print to a Windows printer

1. Click the  icon on the toolbar, or select "Print" from the File menu. The Print dialog is displayed, as
shown below.

2. Select one of the following Print range options.
· To print all pages of the report, select All under Print range. 
· To print a page or a range of pages, select Pages, then enter the page number(s) that you want to

print in the From and To fields.
· To print selected text, highlight the text before you open the Print dialog. Under Print Range, the

radio button next to Selection should already be highlighted. If it isn't, click on the radio button next
to Selection.

3. Select the number of copies you want. If you would like the printed copies to be collated, select
Collate.

4. Click <OK> to print the report.

Steps to print to a PC file

1. Click  on the toolbar, or select "Print" from the File menu. The Print dialog will appear.

2. Select the Print to File option. 
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3. Select one of the following Print Range options.
· To print all pages of the report, select All under Print Range. 
· To print a page or a range of pages, select Pages, then enter the page number(s) that you want to

print in the From and To fields.
· To print selected text, highlight the text before you open the Print dialog. Under Print Range, the

radio button next to Selection should already be highlighted. If it isn't, click on the radio button next
to Selection.

4. After you have made your selections, click <OK>. The Print to File dialog will appear.

5. Select the drive, folder, and name of the file that you want to print to. Click <OK>.
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Save the current report

When a report is run, the results are automatically saved on the PC you are using. This folder can be
changed by selecting "Change Report Output Folder" from the File menu (as described below). You can
manually save reports to an additional location with the following steps.

Steps
1. Select "Save" from the File menu. The Save As dialog will appear.

2. Enter a name and location for the report to be saved.

3. Click <Save> to finish.

Change Report Output Folder

This function allows you to change the location of the information that is automatically saved when a report is
run.

Steps
1. Select "Change Report Output Folder" from the File menu. 

2. Use the Look In drop-down list to select what folder reports will be saved in. (Make sure the name of
the selected folder appears in the drop-down menu box at the top of the dialog.)

3. Click <Select Path> and the dialog will close.

When Open is selected from the drop-down menu, the new folder and its contents will appear in the Open
dialog.
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Running reports in the afterhours
You can set up GOLDWriter reports to run in the afterhours as well as in current time. The advantage of
having a GOLDWriter report run in the afterhours is that it usually costs less and so you can gather current
data to be analyzed in the morning.

To run a report in the afterhours:

1. Select the report you want run in the afterhours from the Report Catalog. (If you have not yet created the
report, use the Report Wizard to first create the report, and once it's been saved, select it from the
Report Catalog.)

2. Select "Schedule for Afterhours" from the Actions menu (or right-click and select "Schedule for
Afterhours"). The Afterhours Schedule Wizard is displayed, as shown below.

3. Enter the next date you want the report to run in the afterhours in the Next Availability Date field. If
you want the report to run at monthend continuously for the next several months, you would enter the
monthend date in this field, and then every monthend thereafter the system would run the report on that
date. To run the report in tonight’s afterhours, place tomorrow’s date in the Next Availability Date.
This will run the report in tonight’s afterhours and make the report available for download at the
beginning of day tomorrow.

4. Select either of the following checkboxes:

R Process at end of previous day: The system will run the report in the afterhours of the previous
day of the Next Availability Date. For example, if running the report on 8/13/2013, the system
will pull data from the end of business day on 8/12/2013.

R Process at start of availability day: The system will run the report at the conclusion of the
afterhours but before the start of the Next Availability Date. For example, if running the report
during the afterhours of 08/12/2013, the system will pull data at the conclusion of the afterhours
process of 08/12/2013 and make the report available at the start of business day on 08/13/2013.
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5. Enter how often you want the report to run in the Frequency drop-down field. Use this field in
conjunction with the Occurs Every field. For example, if you select "Monday" as the Frequency and
"4" as the Occurs Every, the report will run every fourth Monday. Note: The Next Availability Date
needs to match up with the day or monthend selections. For example, if you have the Frequency set
to Monday, and the Next Availability Date is set for a Wednesday, the system will give you an error
and ask you to change the Next Availability Date to a date that reflects a Monday.

6. Enter an expiration date for when you no longer want the report to run in the afterhours in the
Expiration Date field.

7. Select which set you want the report to run: a production set or a monthend set. Production sets are
usually realtime, current data. Monthend sets collect data from a monthend file.

8. Click <OK> and the report will be saved to the Report Catalog, and a clock icon  will be displayed in
the Report Number column for that report. The clock icon indicates the report is set up to run in the
afterhours. If you want to remove the afterhours setup, right-click the report in the Report Catalog and
select "Remove From Afterhours."
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Copy an Existing Report
Using GOLDWriter, you can easily copy an existing report and create a new report based on the original
setup.

To copy an existing report:

1. On the Report Catalog, select the report to be copied by right-clicking on it in the list. The right-click
pop-up menu appears, and the Copy function is enabled.

2. Select the "Copy" function from the right-click menu (or press <Ctrl> + C), and then right-click and
select "Paste" (or press <Ctrl> + V).

A prompt appears asking you where you would like to save the newly copied report: on the host or on
your computer.

3. Select where you want to save the copied report. The new report is displayed at the bottom of the
Report Catalog with "Copy of" at the beginning of the original report's title. For example, a report titled
"Delinquency Report" would now be titled "Copy of Delinquency Report."

From here you can make any changes to the copied report by double-clicking on it and making changes in
the Report Wizard. Give the report a new title, if needed. 

" Remember: FPS GOLD has already created many report examples for you to copy, edit, and use.
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View How Much a Report Costs to Run
Each GOLDWriter report varies in how much it costs to run. Some reports are only a few cents, while others
cost more. Each time a GOLDWriter report is run, a billing charge is created. 

Additionally, if you run reports in batch mode, it can save your institution about 30 percent per report. When
"Run Batch Mode" is selected from the Actions menu, the system assigns the report the lowest priority on
the host. Because the report is assigned a low priority on the host, the report will take more time to run in
comparison to running a report normally. The advantage of running a report in batch mode is the cost savings
due to not having the host use excess resources in running your report.

Because we don't know how big each report you set up will be, we do not calculate the billing costs of

running reports until after a report is run. When the results of a report are displayed, the billing icon 
becomes enabled.

C TIP: When setting up a new report, narrow the selection (such as account numbers) to only

include a small range of accounts. Then when the setup is completed, run the report to
verify that it is the way you want it. The cost for this "test" run will be minimal. You can then
modify the report as needed and expand the account number range in Report Wizard Step
1.

When you click this icon , the billing cost of the report is displayed, as shown in the following example:

Your institution is billed accordingly.
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Change Report Setup Folder
This function allows you to change the location where report views are saved on your personal computer.

1. Select "Change Report Setup Folder" from the File menu.

2. Use the Look In drop-down list to select what folder report setups will be saved in. (Make sure the
name of the selected folder appears in the drop-down menu box at the top of the dialog.)

3. Click <Select Path>.

The dialog will close, the Report Catalog will appear, and only the PC setups that have been saved in the new
folder will appear in the Report Catalog.



How to58

© 2024 FPS GOLD. All rights reserved.Last updated: 10/3/2024

How to set up the printer before printing
Before printing, you may need to set up which printer you want your report to print to, what the orientation
(landscape or regular) of the print should be, and what paper type you are using to print.

1. Select "Print Setup" from the File menu.

2. Select the printer, orientation, and paper type needed.

3. Click <OK>.
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Menus
The following is a list of the available menus in GOLDWriter .

 File Menu

 Actions Menu

 Set Menu

 View Menu

 Window Menu

 Help Menu
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File Menu
The File menu in GOLDWriter contains functions that enable you to log on or off the host and print reports.

Function Description

Open Selecting "Open" from the File menu opens the Open dialog, where you can open a
report you have previously saved.

Export This function allows you to export the currently displayed report to another
spreadsheet/database program. (This is set up in Step 5 of the Report Wizard.)

Save Selecting "Save" (<Ctrl> + S) from the File menu opens the Save As dialog, where
you can save and name the results of a report after it has been run.

Print This function opens the Print dialog, which enables you to print the report results
displayed on your screen.

Print Preview This function allows you to see what the report will look like when printed. Other
features include printing, viewing the next page, viewing the previous page, viewing
two pages at a time, zooming in and out, and closing Print Preview.

Print Setup This function is used to select a printer, orientation, and paper size.

Print Font This brings up the Font dialog which allows you to choose the font, style, size,
effects, color, and script of the report you want to print.

Refresh PMDICT
dictionary

This function allows you to update the field information for all the records used in the
creation of a report. This information is updated automatically once daily. Select this
function if you want to include any new field information that may have been created
after the automatic daily update. You normally will not use this function unless
instructed by FPS GOLD.

Change Set/Inst This function is for FPS GOLD use only.

Rebuild GTPC
links

This function is for FPS GOLD use only.

Exit This function logs you off the host and closes GOLDWriter .

Logoff/Logon This function allows you to log off (or log on to) the host.

Change Report
Setup Folder

This function allows you to change the location where report views are saved on your
personal computer. See Change Report Setup Folder for more information.

Change Report
Output Folder

This function allows you to change the location of the information that is automatically
saved on your PC when a report is run. See Change Report Output Folder for more
information.
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Actions Menu
The Actions menu in GOLDWriter is used to make changes to the displayed data or to change the mode
used to enter data. All of these actions can also be used when right-clicking on a report in the Report
Catalog. These actions will appear on a pop-up menu when you right-click on a report.

Function Description

New This function opens the Report Wizard to create a new report.

Edit This function changes according to the currently opened dialog.
· If edit is selected when a report is highlighted, the Report Wizard will open.
· If edit is selected when a work field is highlighted in Step 3 of the Report

Wizard, the work field can be edited.
· If edit is selected when a total is highlighted in Step 6 of the Report Wizard,

the total can be edited.

Run If you select a report listed in the Report Catalog and then select this function, the
system runs the report and displays it on the screen or in another selected
application.

Run & Print This function is similar to the Run function above, except after the report is run and
displays on your screen, the system then prints the report to your default printer.

Note: Make sure your default printer is set up appropriately before choosing this
function. A print dialog does not appear; the print job is sent directly to your default
printer. For more information concerning how to change your default printer, see your
Windows <F1> help and search for "change default printer." Or you can set up the
printer before printing, as described in the How to set up the printer before printing
topic.

Run Batch Mode This function operates similarly to the Run function. If you select "Run Batch Mode"
after selecting a report on the Report Catalog, GOLDWriter will run the report in
batch mode. This means that GOLDWriter requests a lower priority from the host to
run the report. The biggest difference when running the report in batch mode is that
the cost of the report will be about 1/3 less, and the report may take a little bit longer
to run. However, in most cases the run time is about the same.

Run on PC
Database

This function runs the report off of a database you've saved on your PC.

Schedule for
Afterhours

Use this function to schedule a report to run in the afterhours. When you select the
report on the Report Catalog, and then select this function, the following dialog box
appears:
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Function Description

Use this dialog box to set up when you want this report to run. You can set the next
date you want the report to run; whether to run the report at the end of the previous
day or start of availability date; the frequency you want the report to run; the number
of times the report run occurs during that frequency; the expiration date of when you
want the afterhours to stop running the report; and which set you to run for this
report.

Click <OK> when you have set up your options, and the report will run automatically
in the afterhours as your requested.

Remove from
Afterhours

Select this function to remove any reports scheduled to run in the afterhours, as
described above. If this option is grayed out, the report is not scheduled to run in the
afterhours.

Available
afterhours runs

Select this function to view all available downloads of the selected report that were
run in the afterhours. If this option is grayed out, the report is not scheduled to run in
the afterhours. If no reports are displayed in the dialog box that appears when this
function is selected, no reports were downloaded from the afterhours run for this
report.

Refresh Afterhours
Copy

Select this function to refresh the list of reports that have been downloaded from the
afterhours. This is useful if you logged onto GOLDWriter and left it open during an
afterhours run, and now want to view any reports that were downloaded. Rather than
logging out and logging back in, you can select this function, and the select the
"Available afterhours run" function, as described above.

Install as Host
Selection

This function saves the report parameters, so it can be run in CIM GOLD by
GOLDMiner.
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Function Description

Copy This function allows you to copy an already existing report from the Report Catalog,
and create a new one based on that reports set up. For more information, see the
Copy an Existing Report topic.

Paste Selecting "Paste" from the Actions menu (or press <Ctrl> + V) allows you to paste
whatever was last saved to the Windows  clipboard at the current cursor position.

Delete This button deletes the selected object or text.

Refresh This function refreshes and displays the Report Catalog. This allows you to easily
see if more reports in the Report Catalog have been added or modified by other
employees.

Find This function allows you to search through the currently displayed catalog or report.
The following steps explain how to search for information in a report.

1. Right-click on the report or catalog and select "Find" from the pop-up menu,
or select "Find" from the Actions menu.

The Find dialog will appear, as shown below.

2. Enter any word or value in the Find what field.
3. If you enter multiple words, and you want to find them in the exact same

order, check the Match whole word only box.

4. If you want to match the case, check the Match case box.
5. Select Up or Down in the Directions box.
6. Click <Find Next> to search for your keyword or value.

When a field is highlighted, press the space bar on the keyboard to select the
field.
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Set Menu
The Set menu in GOLDWriter allows you to switch between Production, MonthEnd, and Test sets by clicking
on the needed set.

Function Description

Production Select "Production" from the Set menu if you want to run reports in production
mode. Production files are live customer data files.

MonthEnd Select "MonthEnd" from the Set menu if you want to run reports in monthend mode.
Monthend files reflect live data as of the last day of the last month.

Test Select "Test" from the Set menu if you want to run reports in test mode.  You should
only make this selection if you have developed a test system complete with
accounts and other data records.

Display 'Choose the
desired data file'
Dlg During Logon

This is an option, and if a checkmark is displayed next to this option, then when you
log on, the system asks what data file you want to use to run GOLDWriter reports:
production, monthend, or test.

See the following example of this dialog box:

To disable this dialog box from appearing on logon, select this option from the Set
menu so that a checkmark is not displayed next to it.
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View Menu
The View menu in GOLDWriter enables you to toggle the toolbar and status bar on and off.

Function Description

Toolbar This function toggles the toolbar on and off.

Status Bar This function toggles the status bar on and off. The status bar is at the very bottom
of the screen, as shown below. It shows error information or other data that may be
pertinent to actions on the screen. 

Billing Information This function toggles the billing information on and off. The billing information is the
amount FPS GOLD charges to run this report. This function is only available after a
report is run, or after you've selected a report on the Report Catalog screen.
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Window Menu

The Window menu enables you to arrange the open windows in GOLDWriter . This menu will also display all
the windows you have open.

Function Description

New Window This function opens the currently displayed report or catalog in a new window.

Cascade This function resizes and overlays the open windows with their title bars visible.

Tile This function resizes and arranges open windows side-by-side so that all of the
windows are visible.

Arrange Icons This function arranges all minimized windows into the bottom left-hand corner, if they
are not already there.
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Help Menu

The Help menu contains functions that enable you to find help and view information about GOLDWriter .

A note concerning GOLDWriter help: 

Windows no longer supports .hlp files, which are older
version of help files. However, when you press <F1> from
GOLDWriter, a message may appear from Microsoft
directing you how to fix the help error by downloading an
executable file that allows hlp files to be opened. Follow
those steps in order to see help. 

However, everything contained in help is also found in the
DocsOnWeb GOLDWriter’s User’s Guide. So if you need
help, it might be easiest just to consult DocsOnWeb.

Function Description

Help This function opens the first page of the GOLDWriter Online Help System.

Context Help This function opens the help topic that relates to the screen displayed on the screen.
For example, if Report Wizard Step 3 is displayed, selecting this option will bring up the
help topic concerning Report Wizard Step 3.

Help Finder This function allows you to enter keywords to search for help topics.

About
GOLDWriter

This function opens the About GOLDWriter dialog, which shows the version number of
GOLDWriter , copyright date, and number of sessions in use.

What's New This function opens the Version History dialog. The dialog displays all changes and

improvements made to each version of GOLDWriter .

Find IDs This menu item is for FPS GOLD use only. It shows a context-sensitive number for each
screen, so help can be tied to that screen. If a checkmark is displayed next to this item
and press <F1> for help, a dialog box appears showing context numbers. In order to see
help, make sure no checkmark is displayed next to this function.

https://secure.fps-gold.com/docsOnWeb/uguides/GOLDWriter/index.html
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Shortcuts
Click on the links below to find information designed to help you easily perform GOLDWriter tasks.

Toolbar icons

Keyboard shortcuts
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Toolbar Icons
The toolbar is a quick way to access more frequently used functions. The basic toolbar will always be
displayed according to default. To view or hide the toolbar, choose "Toolbar" from the View menu.

Icon Description

Click this icon to log on to GOLDWriter. If you already logged on to GOLDWriter, click this icon to
log off GOLDWriter.

Click this icon to create a new GOLDWriter report. For more information, see Creating a New Report.

Clicking this icon opens the Report Catalog, which displays all the reports that have been set up for
your institution in GOLDWriter. For more information, see Open the Report Catalog for more
information.

Click this icon to schedule reports to run in the afterhours. For more information, see Running reports
in the afterhours.

Clicking this icon brings up the Open dialog, where you can open a report you have previously saved
on the network or your computer.

Click this icon to export the currently displayed report to another spreadsheet/database program.
(This is set up in Step 5 of the Report Wizard.)

Click this icon to save and name the results of a report after it has been run.

Click this icon if you want to copy a selected report on the Report Catalog screen and save a new
one. See Copy an Existing Report for more information.

Click this icon to paste the report you copied as described above.

Click this icon to view how much a report costs to run.

Clicking this icon opens the Print dialog, which enables you to print the report results displayed on
your screen.

Click this icon to view the help topic for the screen displayed.
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Keyboard Shortcuts
The following is a list of keystrokes that will help you perform GOLDWriter  tasks quickly.

Keystroke Description

<Ctrl> + C Press these keys to quickly copy any information you have selected. You can also use
these keys to copy an existing report, as explained in the Copy an Existing Report topic.

<Ctrl> + D If you select a report in the Report Catalog and then press these keys, you can delete the
report. The following message will be displayed:

Click <Yes> and the report will be deleted, as well as any afterhours scheduling of that
report.

<Ctrl> + E If you click these keys after selecting a report in the Report Catalog, it causes the Report
Wizard to be displayed. <Ctrl> + E indicates that you want to edit parts of the report setup.

<Alt> + F + L Pressing these keys either logs you on or logs you off GOLDWriter.

<Ctrl> + N Press these buttons to bring up a new Report Wizard, where you can enter new parameters
for a report setup.

<Ctrl> + V Press these keys to quickly paste any information you have selected. You can also use
these keys to paste a copied report, as explained in the Copy an Existing Report topic.

<F5> Refreshes the Report Catalog.

<Ctrl> + R If you select a report in the Report Catalog and press these keys, the report will run and be
displayed on your screen.

<Ctrl> + S Press these keys to save the report results (if that is displayed), the report setup (if you
select a report from the Report Catalog), or the Report Wizard (if you are working through
the Report Wizard).
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Appendix A - Special Work Field Calculations

For your convenience, several examples of loan work field calculations are displayed. These could be used
in Report Wizard Step 3: Create Work Fields. For example, in the first example in the table below, you
would title the work field "TOTDUE," then you would enter the calculation logic, as shown in the following
example.

The following table describes these calculations.

Loan Calculations

Calculation Description

TOTDUE = LNPICN (P/I

Payment)
+ LNR1CN (Reserve 1
Payment)
+ LNR2CN (Reserve 2
Payment)
+ LNLATE (Late
Charges)
- LNPRTL (Partial
Payments) 

Next Payment Due
This will work in all cases except when the Next Payment Due involves
a P/I or a reserve payment change, or if a Subsidy Payment amount is
used, or on a payment method 5 (line-of-credit) loan with payment types
2-7. See the following variations in the next rows.

TOTDUE = LNPICN (P/I
Payment)
+ LNR1NX (Next
Reserve Payment)
+ LNR2CN (Reserve 2
Payment)

Next Payment Due (2)
Use this when there is a next Reserve 1 payment pending (usually after a
Reserve Analysis) that will become effective with the next payment due. 

Note: If you do not use either of the reserve accounts or the Partial
Payment field, they may be omitted from the calculation.
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Calculation Description

+ LNLATE (Late
Charges)
- LNPRTL (Partial

Payments) 

TOTDUE = LNPINX (Next P/I
Payment)
+ LNR1CN (Reserve 1
Payment)
+ LNR2CN (Reserve 2
Payment)
+ LNLATE (Late
Charges)
- LNPRTL (Partial
Payments) 

Next Payment Due (3)
Use when there is a pending next P/I payment that will become effective
with the Next Payment Due (ARM only).

Note: If you do not use either of the reserve accounts or the Partial
Payment field, they may be omitted from the calculation.

DAYS = TODAY (today's
date)
B LNRLFD (Date of
1st finance charge)

DAILY = LNRATE ÷ 365

AMTDUE = LNPBAL
* DAILY
÷ 100
* DAYS
R 2
+ LNLATE

Finance Charges Due To Date
This calculates a finance charge plus any outstanding late charges, from
the date of the last finance to today, on payment method 5 loans (line-of-
credit) that are using a daily interest (D) calculation. 

Note: You can also add the mnemonics LNRLP1 through LNRLP5, after
the LNLATE (late charges), to include any unpaid billed amounts.

LINSTBAL = 100
- LNISLD (percent
sold)
* LNPBAL (principal
balance)
÷ 100
R 2 

Institution Balance
This is only for sold loans. This calculation will compute the institution's
portion of the balance. If the loan is 100% sold, the result will be 0.

RMTERM = LNMATD
(maturity date)
B LNDUDT
(payment due date)
÷ 30.4 (average
days)
R 0 

Remaining Term
This calculation does a comparison between the current payment due
date on file and the maturity date to determine the amount of time (in
months) left on this loan. See the other RMTERM description below for a
variation of this same calculation.

RMPMTS = LNMATD
(maturity date)
B LNDUDT
(payment due date)

Remaining Number of Payments
The use of the frequency in the calculation allows for loans with other than
monthly payments.
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Calculation Description

÷ LNFREQ
(frequency of
payments)
÷ 30.4
R 0 

RMTERM = LNMATD
(maturity date)
B LNDUDT (pmt
due date)
÷ 30.4 
R 0 

FACTOR = LNPBAL (princ
bal)
* REMTERM

WTERM@ = FACTOR
÷ LNPBAL (princ
bal)
R 0 

Weighted Average Remaining Term
Uses two separate calculations to arrive at the desired result. First, the
calculation for remaining term (see RMTERM above) and then the
calculation to compute the average, itself requiring two steps to complete.
Notice the "@" used in the result mnemonic. This is the mnemonic you
will print on your report.

FACTOR = LNPBAL
(principal balance)
* LNTERM (term in
months)

WTERM@ = FACTOR
÷ LNPBAL
(principal balance)
T 0 

Weighted Average Term
This is the same as the previous calculation, weighted average remaining
term, except that it uses the full term instead of the remaining term.

LTV = LNPBAL (principal
balance)
* 100
÷ LNCALC (appraisal
amount/selling price) 

Loan-to-Value Ratio
The special mnemonic, LNCALC, is used to determine the lesser of the
appraisal amount or the selling price.

FACTOR = LNPBAL (principal
balance)
* LNRATX (effective
rate)

WRATE@ = FACTOR 
÷ LNPBAL (principal
balance)
R 3 

Weighted Average Rate
The special mnemonic, LNRATX, is used to determine the rate in effect
on any loan pulled for your report. There is a different rate used on an
ARM than on a fixed rate or an LIP. Notice the use of the "@" in the
result mnemonic to determine the weighted average. See below for a
variation of this calculation.

LINSTBAL = 100
- LNISLD (percent

Weighted Average Rate (2)
The same calculation as above with the "institution portion of balance"
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Calculation Description

sold)
* LNPBAL (principal
balance)
÷ 100
R 2

FACTOR = LINSTBAL
* LNRATX

WRATE@ = FACTOR
÷ LINSTBAL
R 3 

calculation added in and used instead of the principal balance. May be
used if part or all of your loans are sold to investors.

DLPMTS = TODAY (today's
date)
B LNDUDT
(payment due date)
÷ 30.4
T 0 

Number of Past Due Payments
This is a comparison of the date you run your report and the payment due
date on file. The result is truncated to "zero" number of decimal places to
provide for a whole number. If you need a more accurate result, increase
the "0" to a "1" (or more if desired). 

For example: If the loan is 3 1/2 months delinquent, the calculation at the
left will show the loan as being only 3 months delinquent. Whereas, if the
"0" were changed to a "1," the answer would be 3.5. You can also round
to the nearest month by replacing the "T" with an "R."
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Appendix B - Special Loan Field Mnemonics

FPS GOLD has created special loan "work" fields (mnemonics). The fields eliminate the need for you to
create work fields to obtain the data. Most of these work fields begin with LNW (see example below). The
following table explains the fields. Note: These fields (mnemonics) would be used in Report Wizard Step 2:
Select Fields.

Field Description

LNWACRIN Calculated accrued interest. This GOLDWriter and Variable screen mnemonic will
accrue loan interest either to or through today. The calculation is the same calculation
that the Payoff screen uses. The mnemonic uses the same institution option as the
one used for payoffs to determine if the calculation is to or through today (institution
option OPTD I1DY). 

WARNING: This mnemonic does not use the Payoff record. If you have already
created a payoff record on the Loan Payoff screen and you run a report using this
mnemonic, but today is not the payoff date, the accrued interest will be different. This
is exactly the same as LNWACRINT.

LNWACRINT See LNWACRIN above.
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Field Description

LNWAMPD Formatted ARM start of accrual period.

LNWBINX Formatted ARM base index.

LNWCALC Lesser of appraisal or sale price. If the Selling Price (LNSELL) is zero, the this uses
the appraisal amount (LNAPAM). If the appraisal amount is 0, then this is the selling
price. If neither is zero, then the lesser of the appraisal amount or selling price is
used.

LNWCLTV Current LTV (loan to value). If either the principal balance (LNPBAL) or LNWCALC are
zero, then this is 0. Otherwise, this is the principal balance plus secondary balance
(LNBAL2) times 100000 times 1000 divided by LNWCALC (see definition above). The
calculation looks as follows:

LNPBAL = 0 or LNWCALC = 0, then 0.

or else: 

(LNPBAL + LNBAL2) * 100000 * 1000 / LNWCALC

LNWCPLTV Current personal property LTV. This is calculated using the LNWCLTV calculation
(see below) from LNVAL macro on FPLW record.

LNWDAYLT Number of days late. This work field calculates the number of days a loan is past due.
The calculation is:

Today - Due Date (for the loan)

If the loan due date is in the future, the field will be zero (0).

LNWDUMAT Earliest of the due date or maturity date. LNWDUMAT returns the earlier of the loan
due date (LNDUDT) and the loan maturity date (LNMATD). If one of the dates is blank,
it uses the date with information in it. This mnemonic should be helpful in auditing
regulatory reports.

LNWHOLD Searches for data in hold code 1 and 2.

LNWINSBL Institution balance. This is the principal balance (LNPBAL) minus LNWINVBL (see
definition below).

LNWINVBL Investor balance. This is the principal balance (LNPBAL) times the percent sold
(LNISLD) rounded to three decimal places.

LNWLIPD Disbursed LIP balance. If the LIP Method Code (LNLMTH) is 103, then this is the
same as the principal balance (LNPBAL). Otherwise, this is the principal balance
minus the LIP balance (LNLBAL).

LNWLMTH Months between open and first rate change. This calculates the number of months
between the loan open date and the first rate change date. This calculation is also
displayed on the ARM Detail screen (Months Between Open and 1st Rate Change
field).
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Field Description

LNWLTOT Total charges. If the LIP Method Code (LNLMTH) is 0, then this is 0. Otherwise, this
is the LIP Charge Amount (LNLCGA) plus the LIP Prior Unpaid Billing amount
(LNLPCG).

LNWOLTV Original loan to value ratio. This is the original balance (LNOBAL) divided by the lesser
of the appraisal amount or the selling price (LNCALC) rounded to three decimal
places. If either the appraisal amount or the selling price is zero, it uses the field with
the amount in it.

LNWOPLTV Original personal property value. This is calculated using the LNWOLTV calculation
(see above) from LNVAL macro on FPLW record.

LNWPDUE Payment due. This is the CALCPMT calculation from INTCA macro. But if this is a
line-of-credit loan (payment method 5) and the Remaining Unpaid fields
(LNRLP1,2,3,4,5) are all zero (0), then LNWPDUE is zero as well.

LNWRATX LNWRATX is the loan effective rate. This mnemonic will return the effective rate based
on the status of the loan. The accrual rate on adjustable rate loans will use LNAMRT,
LIP will use LNLRAT, and all other loans will use LNRATE.

LNWRLAV Average daily balance.

If this is a line-of-credit loan (payment method 5), then:

Use the later of the date of last transaction (LNTRAN) or date of last finance
charge (LNRLFD). Take the difference in days between this date and today's date.
This is called WORK1. Now take the difference in days between the date of last
finance charge (LNRLFD) and today, and this is called WORK2. If WORK2 is
equal to zero, then use value of 1 for WORK2. Then, LNWRLAV is equal to the
principal balance (LNPBAL) * WORK1/WORK2. If the resulting amount of
LNWRLAV is zero, then the system uses loan principal balance.

If not a line-of-credit loan:

Do Work call to FPSAVAB0 and use balance returned.

LNWTDUE Total due. Calculated from the LNVAL macro.

LNWUNDIS and
LNWUNDISB

Undisbursed Balance
The calculations are included with this mnemonic. It will display the undisbursed
balance for either LIP or payment method 5 loans (line-of-credit). This mnemonic gives
you the ability to display the undisbursed amounts for both LIP or payment method 5
loans in the same column. 

· For LIP loans, the mnemonic will display the LIP undisbursed balance by
reading the Undisbursed Balance field on the Account Construction Detail
screen, Balances, Rates & Billing tab. The LIP method code must be greater
than 0. 

· For payment method 5 loans, the undisbursed amount is calculated as follows:
Credit Limit - Principal Balance = Undisbursed (for revolving LOCs), or
Credit Limit - Credit Used = Undisbursed (for non-revolving LOCs).
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Field Description

WARNING: If a loan has been set up to be both a payment method 5 and an LIP, the
payment method 5 calculations will be displayed.

LNWWWA Web active.

Lienholder and
Property
Mnemonics 

Lienholder and property records mnemonics are IL for lienholder and IP for property
records. There can be several properties per loan and also several lienholders per
property.

These fields work similarly to LIP or reserve disbursements and act as the master
when read with loans. Lienholders are the master if read with properties.

"LNC" instead of
"LN"

If you change the "LN" part of a loan mnemonic to "LNC", the loan dates will be
displayed with four-digit years, in MMDDCCYY format. For example, to have four-digit
years displayed for the loan due date, use the mnemonic "LNCDUDT" instead of
"LNDUDT." Note that this is only available for LN mnemonics. The RD (reserve), IN
(insurance), etc. do not have this capability.

LNRINF LNRINF displays the last interest rate and the date the rate went into effect. The data
is all displayed on one line and appears with the date first, then the rate. For example,
0401130875000 would be:

Date: 04-01-13 
Rate: 08.75000
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Appendix C - Report Examples
Example: Escrow Reserve Audit—All

Example: Escrow Reserve Audit Taxes Only



Appendix C - Report Examples80

© 2024 FPS GOLD. All rights reserved.Last updated: 10/3/2024

Investor Balance Report

This is a report that was created to display the investor balance and institution balance for each investor
loan on the system. This report can help with the research of errors on the Loan Management Summary by
Type (FPSRP030) report. See the examples below:

Report Wizard Step 1: Enter Basic Information

https://secure.fps-gold.com/docsOnWeb/loans/LoanReports/llr030.htm
https://secure.fps-gold.com/docsOnWeb/loans/LoanReports/llr030.htm
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Select the fields to be used in this report using Report Wizard Step 2: Select Fields. You can see the list of
fields selected  (under the Report Column Headings) in the example below.

Skip Report Wizard Step 2A: Enter Sub-record Selection Logic.

For Report Wizard Step 3: Create Work Field Columns, you will need to create three work fields: PRINBAL,
INVBAL, and INSTBAL. You must set up these work fields in this order. The work fields are set up as
shown in the following examples.

1. Work field calculation for PRINBAL:
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2. Work field calculation for INVBAL:

3. Work field calculation for INSTBAL:
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Set up Report Wizard Step 4: Enter Row Selection Logic exactly as it is set up in the following example:

 
Complete Report Wizard Step 5, Step 6, and Step 7 as needed, then run the report.
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